
UnixWare 7.1.3 Update Pack 2
New Features and Notes

September 18, 2003 

This document provides installation instructions, new feature descriptions, and release notes for Unixware 7.1.3 Update Pack 2. Complete
UnixWare documentation is available on SCO Web Site under Documentation and Support. Your UnixWare system serves the UnixWare
documentation set, including manual pages, on http://hostname:8458 (where hostname is the network name or IP address of the UnixWare
system).
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Installation Notes

About Maintenance Packs and Update Packs

There are two support "tracks" for UnixWare 7.1.3:

Maintenance Packs 

A Maintenance Pack (MP) is a collection of fixes for reported problems distributed as a single installable
package. Maintenance Packs are made available periodically when such fixes are available, and can be
downloaded and installed free of charge. Maintenance Packs are cumulative, so only the latest one needs to
be installed. If installed individually, they must be installed in the order they are issued (i.e., MP1, MP2, etc.).
A Maintenance Pack typically is accompanied by a single text file with installation instructions and release
notes.

It is important to note that a Maintenance Pack cannot be installed onto a system that already has an Update
Pack installed. This restriction ensures the integrity of the software installed on your system. 

Update Packs 

An Update Pack (UP) is a collection of features, enhancements, and problem fixes distributed as a single
package or set, plus additional packages. Update Packs are made available quarterly (for a licensing fee) to
registered customers of the SCO Update Service. Individual package and set images, as well as a CD image
with all packages and sets included, are published on the Update Service download site. Update Packs are
cumulative, and include all current Maintenance Packs, so only the latest Update Pack needs to be installed.
If installed individually, they must be installed in the order they are issued (i.e., UP1, UP2, etc.). The online
documentation, both DocView guides and traditional manual pages, is also updated with descriptions of new
features and fixes.

In general, Update Packs can be installed on top of previously issued Maintenance Packs. Each Update
Pack comes with full documentation, including installation and release notes (like the document you are
reading now), that explain the target system requirements.

Switching Tracks

If you already have one or more Maintenance Packs installed, you can switch over to the UP track by installing an
Update Pack with the same or later number. For example, If you have Maintenance Pack 2 installed, you can
switch over to the UP track by installing Update Pack 2 or later.

If you are an Update Pack customer and want to switch over to the MP track, you must first remove all Update
Packs installed on your system (in the reverse order they were installed), and then install the latest Maintenance
Pack. For example, if you loaded UP1 and then UP2 onto your system, and want to switch over to the MP track,
remove UP2 and then UP1 from the system. Once the Update Packs are removed, install the latest available
Maintenance Pack.

Release 7.1.3 Maintenance Packs and Update Packs are available from the UnixWare 7.1.3 Supplements Web
Page.

System Requirements

Update Pack 2 can be installed only on a Release 7.1.3 system with one of the following software configurations
(MP means "Maintenance Pack" in the following table, UP means "Update Pack"):
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Supported Configurations for Installing Update Pack 2
UnixWare 7.1.3 (no MPs or UPs)

UnixWare 7.1.3 + MP1

UnixWare 7.1.3 + MP1 + MP2

UnixWare 7.1.3 + MP2

UnixWare 7.1.3 + MP1 + UP1

UnixWare 7.1.3 + UP1

As shown, Update Pack 2 can only be installed on top of previously issued Maintenance Packs and Update Packs.
For example, you must remove any Maintenance Pack later than MP2 using pkgrm(1M) before installing Update
Pack 2. Use the pkginfo(1M) command or the scoadmin application installer to check your current software
configuration.

Please Note: If you install Update Pack 2 on a system with MP1 or MP2 (or both) already installed, do not attempt to remove MP1 or MP2 from
the system after installing UP2. This will lead to unexpected system behavior.

Obtaining Update Pack 2

Update Pack 2 is available to customers who have registered their copy of Release 7.1.3 at the SCO Update
Service Registration web site. Once registered, you can download Update Pack 2 as instructed in the registration
letter you receive via email, as either separate package datastream images or a single CD-ROM ISO image. The
ISO image can be written to a CD-ROM using any Windows or Unix CD recording software, such as cdrtools on
UnixWare. The ISO image file can also be mounted directly without being written to a CD, as shown in the
procedure below. Customers can also register to receive Update Packs on CD-ROM directly from SCO. For more
information, please go to the UnixWare 7.1.3 Supplements Web Page.

Licensing Update Pack 2

A registered SCO Update Service (SUS) Enabling license is required to install the Update Pack Set. If you attempt
to install the uw713up2 set on a system that does not have a registered SUS license, the installation will fail.

An SUS Enabling license can be purchased when you order Release 7.1.3 as part of your License Edition (e.g.,
Base, Departmental, Enterprise, etc.). It can also be purchased separately. Contact your software supplier if you
do not have an SUS license.

To check your current licenses, launch the SCOadmin License Manager from the graphical desktop, or from the
command line (as root):

scoadmin license

The License Manager's main screen displays the currently installed licenses. One of these should mention the
SCO Update Service. If you do have a SCO Update Service license installed, it must also have a "Y" in the
Registered? column, in order to install the Update Pack Set.

The entire process of installing licenses on your system and registering your SCO Update Service license is
described in the online documentation under Installation and Licensing>Getting Started Guide>CD Contents,
Licensing, Installation Profiles, and Support. The Getting Started Guide is also available on the UnixWare Doc
Web Page.

Update Pack 2 CD Contents

Update Pack 2 consists of a single Update Set named uw713up2, as well as a number of additional updated
packages. See the next section for installation instructions. 

Update Pack 2 CD Contents
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Package/Set Description

uw713up2.image Set

The Update Pack 2 Set installs these packages: 

libc - Updated Runtime C Library 
libthread - Updated Runtime Thread Library 
uw713u2 - Other updates that did not require a package recut 

adpu320 package New Adaptec Ultra320 Family PCI SCSI HBA d2.0

adst70 package Updated Adaptec Ultra160 Family PCI SCSI HBA d3.14

basedoc package Updated online topics

baseman package Updated manual pages

basex package Updated X11R6 Base X Runtime System

glib.image package New Library of utility functions for Gtk 1.2.10 (required for Mozilla)

gtk.image package New Gimp ToolKit 1.2.10 - runtime library for graphical user interfaces to X (required
for Mozilla)

iir package New Intel Integrated Raid (IIR) HBA Driver Package 2.33

j2jre131 package Updated Java 2 SE 1.3.1_08 Runtime Environment 1.3.1

j2plg131 package Updated Java 2 SE 1.3.1_08 Java Plug-in (Netscape and Mozilla)

j2pls131 package Updated Java 2 SE 1.3.1_08 Demos and Debug

j2sdk131 package Updated Java 2 SE 1.3.1_08 Software Development Kit

libIDL.image package New Library for creating CORBA Interface Definition Language (IDL) files 0.6.8
(required for Mozilla)

mozilla.image package New Mozilla Internet Browser 1.2.1

mpt package New LSI Logic Fibre Channel HBA Driver

nd package Updated Network Drivers

nics package Updated Netdriver Infrastructure and Configuration Subsystem

openssh package Updated Secure Shell remote access utility 3.4p1; replaces telnet and rlogin/rsh

openssl package Updated Secure Sockets Layer / TLS cryptography toolkit 0.9.7

qlc2200 package Updated QLogic PCI Fibre Channel HBA Driver

samba package Updated Samba 2.2.4 - A Windows SMB/CIFS fileserver for UNIX

sambamb package Updated Samba 2.2.4 - A Windows SMB/CIFS fileserver for UNIX (multibyte)

uli package Upgrade Wizard for Update Pack 2

xdrivers package Updated X11R6 Graphics Drivers (NVIDIA driver)

xserver package Updated X11R6 X Server

zlib package Updated zlib - General Purpose Data Compression Library 1.1.4
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Installation Procedures

You can install the Update Pack from a single CD ISO image, or from separate package images (see Obtaining
Update Pack 2). 

Please see the section Known Problems and Workarounds before beginning installation of the Update Pack.

Installing Update Pack 2 from CD

The procedure below shows you how to install the Update Pack using the Upgrade Wizard, from either a mounted
ISO CD image, or from a CD to which the ISO image has been written.

NOTE: You must install the uw713up2 set before installing any of the other packages available with Update Pack 2. This is done automatically
by the Upgrade Wizard.

If you are applying the Update Pack to a newly installed or upgraded Release 7.1.3 system, be sure to reboot the system after the Release
7.1.3 installation or upgrade is complete and before you apply Update Pack 2. 

1. Log into the system as root.

2. Do one of the following:

a. If you have a CD with the Update Pack image on it, insert the CD into the primary CD drive and go to
the next step.

b. If you have the CD ISO image, use the marry(1M) and mount(1M) commands, as in this example, to
mount the CD ISO image as a device: 

# marry -a /var/spool/pkg/uw713up2CDimage.iso
/dev/marry/var/spool/pkg/uw713up2CDimage.iso
# mount /dev/marry/var/spool/pkg/uw713up2CDimage.iso /install

3. Install the uli (Upgrade Wizard) package from the CD. Use either the SCOadmin Application Installer from
the graphical desktop, or the following command line:

# pkgadd -d device uli

where device is cdrom1 if you followed Step 2a; or, /install if you followed Step 2b.

4. Once the uli package is installed, launch the Upgrade Wizard. Do one of the following:

a. If you are using a CD in the CD drive (Step 2a), start the Upgrade Wizard by launching SCOadmin from
the graphical desktop and selecting Upgrade Wizard; or, enter the following at a shell prompt: 

# uli

b. If you are using a mounted CD ISO image (Step 2b), start the Upgrade Wizard from the command line
by entering the following command: 

# uli -f device

where device is the name of the directory where you mounted the ISO image in Step 2b (/install in the
example).

5. When the Upgrade Wizard starts, a screen displays a message that the Upgrade Wizard will install the
Update Pack software. Select Next to continue.

6. The Upgrade Wizard displays the Software License Agreement. Select Accept to continue.

7. If you followed Step 4a and used the uli command with no options, skip to the next step.
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Otherwise, if you followed Step 4b and used uli -f, a screen is displayed that lists the primary CD drive and
the directory you specified, with the directory selected as the default installation device. Select Next to
continue and install from the directory.

8. The Wizard checks the contents of the installation device for the Update Pack. Select Next to continue and
begin installing the Update Pack.

9. The Upgrade Wizard automatically installs the Update Pack Set (see the CD Contents), displaying
installation messages in a new window. 

10. When the Upgrade Wizard finishes installing the Update Pack Set, it displays the Package Selection List, a
list of the additional packages on the CD that are not installed automatically by the Update Pack Set. If the
Wizard detects previous versions of any of the Update Pack CD packages on your system, the updated
version on the CD appears in the Chosen Packages list on the right. Use the Remove button to move
packages that you don't want to install from the Chosen Packages list to the Available Packages list. Any
packages that remain in the Available Packages list will not be installed.

NOTE: Some packages on the CD may not be presented in the Package Selection List. This happens when the Upgrade Wizard does
not find a previous version of the package on your system. In order to install such a package using the Upgrade Wizard, you need to first
install the package from the original UnixWare 7.1.3 media used to install the system (along with any prerequisite packages). 
After you are done installing software with the Upgrade Wizard, see the section Installing Additional Packages after the Update Pack Set
and use pkgadd(1M) instead of the Upgrade Wizard to install the Update Pack 2 version of any package not listed for selection by the
Upgrade Wizard. If a package installation fails because a prerequisite package was not found, you will first need to install the
prerequisite package from Update Pack 2 or the original UnixWare 7.1.3 media.

When you are finished choosing packages, select Next to continue. 

11. A summary of your package selections and the space they require on your hard disk is displayed. Select
Next to confirm your selections and continue. Select Previous to go back to the previous step and change
the Package Selection List.

12. After you confirm your package selections, the Upgrade Wizard installs the packages you selected. It
displays a progress bar as each package is installed. When the Wizard is done, select Finish to exit. 

13. If you followed Step 1a, go to the next step.

Otherwise, if you followed Step 1b, unmount the CD image and delete the marry device:

# umount /install
# marry -d /dev/marry/var/spool/pkg/uw713up2CDimage.iso

14. Reboot your system to rebuild the kernel. From the Desktop, use the SCOadmin Shutdown Manager. From
the command line, enter the following:

# shutdown -i6 -g0 -y

15. When the system comes back up, you can log in and check the installation as shown in the section Checking
Update Pack Installation.

If you decide that you want to add additional packages from the Update Pack CD, see the section Installing
Additional Packages after the Update Pack Set. 

Installing Update Pack 2 from the Download Site

Separate images for the Update Set and all available packages on the CD (e.g., uw713up2.image, nd.image,
etc.) are available on the SCO Update Service download site. These are in datastream format and must be
installed using the pkgadd command. Follow this procedure to install the images you download.

NOTE: You must install the uw713up2 set before installing any of the other packages available with Update Pack 2.

If you are applying the Update Pack to a newly installed or upgraded Release 7.1.3 system, be sure to reboot the system after the Release
7.1.3 installation or upgrade is complete and before you apply any Update Packs. 
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1. Download the set and package images from the SCO Update Service, and place them in /var/spool/pkg (or
any other directory that has enough free space to accommodate the images).

2. Enter the following to install the update set:

# pkgadd -d /var/spool/pkg/uw713up2.image all

3. Enter the following command for each additional package image:

# pkgadd -d /var/spool/pkg/imagename all

4. Reboot your system to rebuild the kernel. From the Desktop, use the SCOadmin Shutdown Manager. From
the command line, enter the following:

# shutdown -i6 -g0 -y

5. When the system comes back up, you can log in and check the installation as shown in the section Checking
Update Pack 2 Installation.

Installing Additional Packages after the Update Pack Set

After you have installed the Update Pack 2 Set (uw713up2) and rebooted your system, you can use either the
Upgrade Wizard or the pkgadd(1M) command to install any packages that you did not select when you installed
the Set. The two following sections show you how to install additional packages using either the package images
found on the SCO Update Service Download Site, or the packages on the Update Pack CD image.

If any desired package cannot be installed because a prerequisite package was not found, install the prerequisite
package (either from the Update Pack or the original UnixWare 7.1.3 media), and then attempt to install the
desired package again.

To install additional packages from the CD image:

Using the Upgrade Wizard will re-install the Update Set (uw713up2) automatically before installing additional
packages. Use the pkgadd command if you want to:

load additional packages without re-installing the Update Set 
install .image files from the download site or the Update Pack CD 
add any packages from the CD or CD ISO image not offered for installation by the Upgrade Wizard 

1. Use the Upgrade Wizard:
Follow the Installation Procedure, omitting Step 3. 

OR

2. Use the pkgadd command:
Follow Steps 1 and 2 of the Installation Procedure, and then enter the following:

# pkgadd -d device package...

The device is cdrom1 if you followed Step 2a; or, /install if you followed Step 2b. Replace package with the
names of one or more packages on the CD (see CD Contents). This example installs the nd and nics
packages from a mounted ISO image file:

# pkgadd -d /install nd nics

To install additional package images from the web:

Separate images for the Update Set and all available packages on the CD (e.g., uw713up2.image, nd.image,
etc.) are available on the SCO Update Service download site. These are in datastream format and must be
installed using the pkgadd command. Follow this procedure to install the images you download.
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1. Download the package images from the SCO Update Service, and place them in /var/spool/pkg (or any other
directory that has enough free space to accommodate the images).

2. Enter the following command for each package image:

# pkgadd -d /var/spool/pkg/imagename all

3. Reboot your system to rebuild the kernel. From the Desktop, use the SCOadmin Shutdown Manager. From
the command line, enter the following:

# shutdown -i6 -g0 -y

4. When the system comes back up, you can log in and check the installation as shown in the section Checking
Update Pack 2 Installation.

Checking Update Pack Installation

Once installed, use the following command to confirm that the uw713up2 set has completely installed. The
system should respond with output similar to that shown in the example below:

# pkginfo -lc set uw713up2
   PKGINST:  uw713up2
      NAME:  UnixWare 7 Release 7.1.3 Update Pack 2
       ...
    STATUS:  completely installed

If the STATUS field indicates anything other than completely installed, there was some problem during
installation of the set. Re-install the set and record any error messages displayed. Then, check the Late News and
Support web sites to check for additional Update Pack 1 notes.

To check the installation of other packages, use a command like the following:

pkginfo -l xdrivers

Update Pack 2 New Features

Update Pack 2 contained all the new features listed below, as well as the new features from Update Pack 1. 

Features in the Update Set: 
Compatibility: New Tunable Parameters for 16-bit IPC 
Desktop Login: Default Desktop 
Filesystems: SCOAdmin Filesystem Manager Moved 
Hardware: PCI Serial Support 
Networking: DNS Manager Enhancements 
Printing: Increased Number of Print Jobs 
Security: Core Dump for setuid Processes 
Storage Management: Disk, Partition, and Slice Managers 

Features in Other Packages: 
Hardware: Host Bus Adapter (HBA) Drivers 
Hardware: Network Interface Card (NIC) Drivers 
Hardware: Video Drivers 
Internet Browser: Mozilla 1.2.1 
Networking and Security: Updated OpenSSH and OpenSSL 
Online Documentation: Updated Guides and Manual Pages 
Security: Padding of Short Ethernet Frames 
Security: Updated zlib Data Compression Library 
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Windows Interoperability: Samba 2.2.5 

Features in the Update Set:

The features listed in this section are installed with the Update Pack Set. See the Installation Procedures section
for how to install the Update Pack Set.

Compatibility: New Tunable Parameters for 16-bit IPC

Previously, the system calls shmget(2), msgget(2), and semget(2) returned 32-bit InterProcess Communication
(IPC) IDs for shared resources under UnixWare. OpenServer and Xenix applications, however, expect IPC IDs
that are positive, signed 16-bit numbers.

A new flag, IPC_SMALLID, may be passed in to the IPC routines listed above. If this flag is passed in, then, on
success, the invoked function returns a 16-bit IPC ID. Otherwise, a 32-bit IPC ID is returned.

The IPC_SMALLID flag is introduced for use in cases in which a native UnixWare application requires a small IPC
ID in order to share the ID and associated object with OpenServer or Xenix applications. For example, the Xenix
emulator included with the OpenServer Kernel Personality (OKP) product uses IPC_SMALLID for every IPC ID it
requests, so Xenix applications can use IPC as expected. 

In addition to the IPC_SMALLID flag, three new tunables are also available for cases where the entire system
must be tuned to return 16-bit IPC IDs to support OpenServer and Xenix applications. These tunables are
SHMSMALLID, MSGSMALLID, and SEMSMALLID, and they affect the return values of shmget(2), msgget(2), and
semget(2), respectively. Each has a default value of 0, and a range of values of 0 to 1. Each tunable controls
whether the corresponding IPC system call returns a 16-bit ID by default. If the tunable is set to 0 (the default),
then the corresponding routine always returns a 32-bit ID; if the tunable is set to 1, then the corresponding routine
always returns a 16-bit ID.

The kernel has been modified to always return 16-bit IPC IDs to a running application that it recognizes as an
OpenServer or Xenix executable, regardless of the setting of the above tuneables.

Desktop Login: Default Desktop

The dtlogin(X1) daemon has been enhanced to save the desktop chosen when a user logs in. The next time the
same user logs in, the previously used desktop will be launched, unless the user chooses another from the
Desktop menu on the Graphical Login screen.

Two new keywords that control this feature can be specified in the file /etc/default/login:

SAVEUSERGUI
which can be YES or NO. This is a system wide default which controls whether dtlogin remembers what
window manager the user used last. The default value is YES. 

DEFAULTWINDOWMANAGER
which can be cde, kde, or pmwm. This is a system wide default. If a user hasn't logged into the system
before and doesn't select a window manager from the dtlogin Options > Session menu, then the
DEFAULTWINDOWMANAGER is used. 

Once a user has logged into a graphical desktop, the dtlogin menu Options > Session will display the following
choices:

[Last Desktop Session Selected]
Common Desktop Environment (CDE) and UNIX Personality
Panorama Session and UNIX Personality
KDE2 and Linux Personality (LKP)
Failsafe Session

(If you do not have LKP installed, the entry "KDE2 and Linux Personality (LKP)" will not be displayed.)
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Your default window manager is either the system default window manager (DEFAULTWINDOWMANAGER) as
specified in /etc/default/login or the window manager you previously selected from the Options > Session menu.
You can change your personal default window manager by selecting a new window manager from the Options >
Session menu. Your personal default window manager overrides the system default window manager unless
SAVEUSERGUI is set to NO.

Filesystems: SCOAdmin Filesystem Manager Moved

The SCOadmin Filesystems Manager has been moved from the main SCOadmin screen (started from the CDE or
Panorama Desktop menus, or from the command line with the scoadmin command), to a new Storage folder.
The Storage folder also contains the new Disk, Partition, and Slice Managers, described below.

Hardware: PCI Serial Support

The asy and asyc drivers (see the asyc(7) manual page) are now configured by default to support up to ten total
serial ports. The ports are named following the conventions described in the section Hardware > Configuring Serial
Ports > Serial device node naming conventions in the online documentation. The drivers now support 16654
UARTS on the motherboard, as well as Digi Classicboard and Connecttech Blue Heat PCI cards.

PCI devices honor the resmgr entries created or modified by dcu(1M). Note that only scanned (i.e. not PCI)
devices may be used for kdb(1M) or console devices.

For more information on the ConnecTech and Digi boards mentioned above, see the respective companies' web
sites:

http://www.dgii.com/products/multiport%20serial%20cards/classicboard.jsp 
http://www.connecttech.com/sub/Products/ProductList.asp 

Networking: DNS Manager Enhancements

The DNS Manager (scoadmin dns) has been updated with the following fixes and enhancements:

The DNS Manager will launch only one server deamon. In previous releases, the DNS Manager would
invoke another DNS server when the Manager was started or terminated.

Enhanced the Manager so that it does not remove configuration and zone data file information entered by
other mechanisms (e.g., vi(1) or h2n(1M)). This was a problem in earlier releases.

Enhanced h2n(1M) so that it will work properly with files created or edited by the DNS Manager (e.g., uses
the same conventions, such as zone data file names). In previous releases, you could not use both tools on
the same set of files.

The Server pull down menu now adds options reliably to the current configuration. The DNS configuration
file it produces is validated with the named-checkconf utility. It also cleans up appropriately when
configuration options and statements are removed.

Add and Modify Zones commands for the Primary server type have been improved:

The Modify command now performs more reliably. 
Fixed issues of generating corrupted Zone Data Files via the Manager. 
Greatly improved the allowed character set and format of MAILBOX type entries for the SOA and RP
Resource Records (improved RFC2822 support). 
Improved the allowed character set and format of the HINFO Resource Record. 
Greatly improved the allowed character set and format of the TXT Resource Record. 
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Printing: Increased Number of Print Jobs

The System V LP printing subsystem has been enhanced to allow a maximum of 999 print jobs per printer, or
class of printers. In previous releases, only 999 print jobs for the entire system were permitted.

Security: Core Dump for root Processes

By default, privileged processes (i.e., processes running as root) do not dump core files, to prevent unprivileged
access to sensitive data that may be contained in the core file. (See the core(4) manual page for a description of
core files.) A new tunable parameter (COREFILE_SECURE) has been introduced that, if set in the current
environment of a privileged process, allows the process to dump a core file when a program exception occurs.
Such core files should be protected from unprivileged access by ensuring the file permissions allow only owner
access, and that the file is owned by root. You can do this using the following commands:

chmod 400 corefile
chown root corefile

COREFILE_SECURE can also be set for the entire system using the System Tuner. Enter scoadmin system tuner
at a shell prompt, or launch SCOadmin from the desktop and select System > System Tuner.

Storage Management: Disk, Partition, and Slice Managers

Three new SCOadmin managers provide a graphical mass storage management interface:

Disk Manager 
Manages the logical and physical disk configuration, as well as I/O paths (including Multi-Path I/O). The other
two managers can be launched from this interface to define disk partitions and partition slices. 

Partition Manager 
Add and remove disk partitions. The Slice Manager can be launched from the Partition Manager to display
the slices in a partition. 

Slice Manager 
Displays slices defined within a disk partition. 

These managers are grouped under a new Storage folder in the SCOadmin main window. Start SCOadmin from
the CDE or Panorama desktop menus, or by entering scoadmin at a UNIX shell prompt. Managers can also be
started from the command line using their names; for example, scoadmin disk starts the Disk Manager. Use the
Help button on the main window of any Storage manager to display the online documentation, or look under the
Mass Storage Devices Overview topic at the top level of DocView on http://hostname:8458.

Features in Other Packages:

The features listed in this section are contained in separate packages from the Update Pack Set. To install them,
either select them from the Upgrade Wizard when you install the Update Pack Set, or follow the instructions in the
section Installing Additional Packages after the Update Pack Set. See Update Pack Contents for the list of
additional packages available.

Hardware: Host Bus Adapter (HBA) Drivers

The following HBA drivers are new or updated:

Adaptec Ultra160 Family PCI SCSI HBA d3.14 (adst70) 

This updated version of the adst70 driver fixes a panic that occurred previously on transition to init(1M) state
1.
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Adaptec Ultra320 Family PCI SCSI HBA d2.0 (adpu320) 

This new driver supports the following Adaptec Host Bus Adapters:

Adapter Chip Type

AHA29320x, AHA39320x AIC-7901A, AIC-7902A4 Ultra320 SCSI

Intel Integrated Raid (IIR) HBA Driver Package 2.33 (iir) 

This new driver supports the following Intel® Host Bus Adapters:

Adapter Type

SRCFC22C Dual Channel 2 Gb/s Fibre Channel RAID w/Ultra160 SCSI

SRCS14L Four Port S-ATA RAID

SRCMR Modular RAID on Motherboard Ultra160 SCSI

SRCU-31 Single Channel Ultra160 SCSI RAID

SRCU-31L Single Channel Ultra160 SCSI RAID

SRCU-32 Dual Channel Ultra160 SCSI RAID

Diskette images of these drivers suitable for use during a new installation of UnixWare are available at
ftp://ftp.sco.com/pub/unixware7/drivers/storage.

Also see the Compatible Hardware Page for the latest supported hardware and drivers.

Hardware: Network Interface Card (NIC) Drivers

The nd package contains the following updated NIC drivers.

The bcme Broadcom Server Adapter driver v6.0.15 supports these models: 

3Com 3C996/3C1000/3C94X Gigabit Ethernet
Broadcom BCM5700 NetXtreme Gigabit Ethernet
Broadcom BCM5701 NetXtreme Gigabit Ethernet
Broadcom BCM5702 NetXtreme Gigabit Ethernet
Broadcom BCM5703 NetXtreme Gigabit Ethernet
Broadcom BCM5704 NetXtreme Gigabit Ethernet
Broadcom BCM5704S NetXtreme Gigabit Ethernet
Broadcom BCM5705 NetXtreme Gigabit Ethernet
Broadcom BCM5782 NetXtreme Gigabit Ethernet for hp
HP NC6770 Gigabit Ethernet
HP NC7760 Gigabit Ethernet
HP NC7761 Gigabit Server Ethernet
HP NC7770 Gigabit Ethernet
HP NC7771 Gigabit Ethernet
HP NC7772 Gigabit Server Ethernet
HP NC7780 Gigabit Ethernet
HP NC7781 Gigabit Ethernet
HP NC7782 Gigabit Ethernet
HP NC7783 Gigabit Ethernet

The e1008g Intel PRO/1000 Server Adapter driver v7.0.11 supports these models: 
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PRO/1000 Gigabit Server Adapter PWLA8490
PRO/1000 Gigabit Server Adapter PWLA8490G1
PRO/1000 F Server Adapter PWLA8490SX
PRO/1000 Gigabit Adapter PWLA8490SXG1P20
PRO/1000 T Server Adapter PWLA8490T
PRO/1000 T Server Adapter PWLA8490TG1P20
PRO/1000 XT Server Adapter PWLA8490XT
PRO/1000 XT Server Adapter PWLA8490XTL
PRO/1000 XT Lo Profile Server Adapter PWLA8490XTL
PRO/1000 XF Server Adapter PWLA8490XF
IBM Netfinity Gigabit Ethernet SX Adapter 09N3599
IBM Netfinity Gigabit Ethernet SX Adapter 30L7076
IBM Gigabit Ethernet SX Server Adapter 06P3718
IBM Gigabit Ethernet Server Adapter 22P4618
PRO/1000 MT Desktop Adapter PWLA8390MT
PRO/1000 MT Server Adapter PWLA8490MT
PRO/1000 MT Dual Port Server Adapter PWLA8492MT
PRO/1000 MF Server Adapter PWLA8490MF
PRO/1000 MF Dual Port Server Adapter PWLA8492MF

The eeE8 Intel Pro100 PCI Adapter driver v2.5.4 supports these models: 

PRO/100+ Management Adapter (PILA8900)
PRO/100 Server (PILA8480)
Pro/100B T4 (PILA8475B)
PRO/100 S Server (PILA8474B)
PRO/100 S Server (PILA8474BUS)
PRO/100+ Dual Port Server Adapter (PILA8472)
PRO/100+ Server Adapter (PILA8470)
PRO/100+ Server Adapter (PILA8470B)
PRO/100+ Dual Port Server Adapter (61PMCA00)
PRO/100 (PILA8465)
PRO/100B Adapter (PILA8465B)
InBusiness 10/100 Adapter (SA101TX)
PRO/100 S Management (PILA8464B)
Pro/100+ Management Adapter (PILA8461)
Pro/100+ (PILA8460)
Pro/100+ Management Adapter (PILA8460B)
Pro/100+ (PILA8460BN)
PRO/100 S Management (PILA8460BUS)
Pro/10+ (PILA8500)
Pro/10+ (PILA8520)

See the Compatible Hardware Page for the latest supported hardware and drivers.

Hardware: Video Drivers

The xdrivers package provides a new nvidia graphics driver that supports the following graphics cards from
NVIDIA Corporation:

NVIDIA RIVA TNT2/TNT2 Pro
NVIDIA RIVA TNT2 Ultra
NVIDIA Vanta/Vanta LT
NVIDIA RIVA TNT2 Model 64/Model 64 Pro
NVIDIA Aladdin TNT2
NVIDIA GeForce2 MX/MX 400
NVIDIA GeForce2 MX 100/200
NVIDIA Quadro2 MXR/EX
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Also see the Compatible Hardware Page for the latest supported hardware and drivers.

Internet Browser: Mozilla 1.2.1

The Mozilla internet browser, version 1.2.1, is included in a separate package as an alternative to Netscape
Communicator 4.61 (delivered in the base Release 7.1.3 system). If you install Mozilla using the Upgrade Wizard
when you install the Update Set, all prerequisite packages will be installed as well. If you install Mozilla using
pkgadd(1M), you will need to install them in the order shown (after installing the Update Set) to enable Mozilla on
UnixWare 7.1.3:

basex 
xserver 
glib 
gtk 
libIDL 
mozilla 
j2jre131 
j2plg131 

The j2re131 and j2plg131 packages are required for Java plug-in support only.

For example, if you download all the .image files from the download site to /var/spool/pkg, use the following
commands to install these packages:

pkgadd -d /var/spool/pkg/basex.image all
pkgadd -d /var/spool/pkg/xserver.image all
pkgadd -d /var/spool/pkg/glib.image all
pkgadd -d /var/spool/pkg/gtk.image all
pkgadd -d /var/spool/pkg/libIDL.image all
pkgadd -d /var/spool/pkg/mozilla.image all
pkgadd -d /var/spool/pkg/j2jre131.image all
pkgadd -d /var/spool/pkg/j2plg131.image all

If you are using a mounted CD or CD ISO image (see Step 1 and 2 of Installing the Update Pack from CD),
mounted under /install, enter the following:

pkgadd -d /install basex
pkgadd -d /install xserver
pkgadd -d /install/glib.image all
pkgadd -d /install/gtk.image all
pkgadd -d /install/libIDL.image all
pkgadd -d /install/mozilla.image all
pkgadd -d /install j2jre131
pkgadd -d /install j2plg131

A mozilla(1) manual page is installed with the browser, and can be viewed with the man(1) command or with
DocView on http://hostname:8458.

Using Mozilla in non-English Locales

The following notes apply to using the Update Pack 2 version of Mozilla in locales other than en_US.

1. The mozilla released in the Update Pack 2 has been built for the US English locales. All menus and help
material are in English.

2. Localization of the user interfaces are provided by individual contributors to the Mozilla Localization Project.
These typically:

provide localized chrome files and profile defaults. 
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are provided in the form of Language Packs for specific locales that will will install and register the new
chrome files into the mozilla release. 

3. Language Packs currently available for Mozilla 1.2.1 are:

Asturian, Belarusian, Breton, Catalan, Simplified Chinese (China), Traditional Chinese (Hong Kong),
Traditional Chinese (Taiwan), Czech, Danish, Dutch, English (United Kingdom), Esperanto, Estonian,
French, Galician, German, Greek, Hungarian, Italian, Korean, Lithuanian, Mongolian, Norwegian Nynorsk,
Telugu, Turkish, Romanian, Russian, Slovak, Slovenian, Sorbian, Spanish (Latin America), Spanish
(Argentina), Spanish (Spain), Polish, Portuguese (Brazil) and Ukrainian. 

4. To install individual Language Packs, do the following as root in Mozilla:

a. Select Edit > Preferences > Appearance > Language/Contents. 
b. Under Installed Language Packs, select Download More. This will download the MLP Status web

page. 
c. Select the Language Pack desired under the Mozilla 1.2.1 heading. The language pack will be

downloaded and installed and the chrome registry will be updated. 
d. Repeat for each additional language pack desired on the system. 

NOTE: Do not attempt to download Mozilla "Content Packs". These contain binaries and libraries compiled for locales on specific
operating systems. There are currently no Content Packs for Mozilla running on UnixWare 7, and loading one of them may result in
unexpected behavior.

5. Once a Language Pack is installed, it must be enabled in Mozilla. Select Edit > Preferences > Appearance
> Language/Contents, and choose the Installed Language Pack desired. Then restart Mozilla for the new
language pack to take effect.

6. When using Mozilla in a Japanese locale, Japanese characters may not be displayed as they are typed using
the X input method (invoked by typing Shift+Space). The Japanese characters are instead displayed when
Enter is pressed. This behavior is the default setting of the xim.input_style attribute in the Mozilla browser.
To have characters displayed as they are typed in Japanese locales, add the following line to each user's
java script preferences file (typically $HOME/.mozilla/default/*/prefs.js):

user_pref("xim.input_style", "over-the-spot");

Online Documentation: Updated Guides and Manual Pages

The basedoc and baseman packages contain guide material and manual pages for the new features,
enhancements, and fixes delivered with Update Pack 2. They assume that the packages of the same name from
Release 7.1.3 are already installed. Online documentation is viewed using the DocView documentation server
(docview), at http://hostname:8458, where hostname is the network node name of the UnixWare system (e.g.,
system1, system1.yourdomain.com, etc.) or localhost. The document you are reading now is found under New
Features and Notes.

Networking and Security: Updated OpenSSH and OpenSSL

The OpenSSL package has been updated to 0.9.7 with a security fix that prevents a timing-based attack on cipher
suites used in SSL and TLS. OpenSSL is an Open Source toolkit implementing the Secure Sockets Layer (SSL
v2/v3) and Transport Layer Security (TLS v1) protocols as well as a general purpose cryptography library. A user
level command, openssl(1), is provided that performs a variety of cryptographic functions.

Documentation for OpenSSL is packaged separately in openssld on the UnixWare 7.1.3 Updates and Upgrades
CD #2. The following manual pages are installed under /usr/man, and can be viewed via man(1) or the DocView
Man Pages button (http://hostname:8458): 
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asn1parse.1
ca.1
CA.pl.1
ciphers.1
crl.1
crl2pkcs7.1
dgst.1
dhparam.1
dsa.1
dsaparam.1
enc.1
gendsa.1
genrsa.1
nseq.1
openssl.1
passwd.1

pkcs12.1
pkcs7.1
pkcs8.1
rand.1
req.1
rsa.1
rsautl.1
s_client.1
s_server.1
sess_id.1
smime.1
speed.1
spkac.1
verify.1
version.1
x509.1

bio.3
blowfish.3
bn.3
bn_internal.3
buffer.3
crypto.3
d2i_DHparams.3
d2i_RSAPublicKey.3
des.3
dh.3
dsa.3
err.3
evp.3
hmac.3
lh_stats.3
lhash.3

md5.3
mdc2.3
OPENSSL_VERSION_NUMBER.3
OpenSSL_add_all_algorithms.3
rand.3
rc4.3
ripemd.3
rsa.3
sha.3
ssl.3
threads.3

config.5

des_modes.7

For more information on OpenSSL see the OpenSSL Web Site.

The openssh 3.4p1 package has been updated to fix several minor problems with the location and file
permissions of /etc/sshd.pid, and the location of /usr/X11R6.1/bin/xauth. OpenSSH is a suite of network
connectivity tools that encrypts all traffic to effectively eliminate eavesdropping, connection hijacking, and other
network-level attacks. OpenSSH provides a variety of secure tunneling capabilities and authentication methods.
This version fixes a major security vulnerability present in versions 2.3.1 to 3.3, and is built with privilege
separation and compression turned on. SSH protocol versions 1.3, 1.5, and 2.0 are supported.

The OpenSSH suite includes:

ssh(1) (slogin), alternative to rlogin and telnet 
scp(1) (alternative to rcp) 
sftp(1) (alternative to ftp) 
sshd(8), the SSH server daemon (alternative to rshd) 
sftp-server(8), the SFTP server daemon (alterative to ftpd) 
ssh-agent(1), the authentication agent, and associated tools: ssh-add, ssh-keygen, ssh-keyscan 

Manual pages are provided for all of the above commands, as well as pages for the ssh_config(5) and
sshd_config(5) SSH client and server configuration files. To display them, use the man(1) command or DocView
on http://hostname:8458. For more information on OpenSSH, please go to the OpenSSH Web Site
http://www.openssh.org/manual.html.

NOTE: You should install OpenSSL from the Update Pack before installing OpenSSH, even if you have a previous
version of OpenSSL already installed.

Security: Padding of Short Ethernet Frames

Ethernet packets are required by RFC894 and RFC1042 to be a minimum of 46 bytes. Smaller packets are
required to be padded with zeros to the 46 byte minimum, but the standards do not specify what part of the system
(e.g., the kernel, the driver, etc.) should do the padding. As a result of this ambiguity in the standard, some drivers
will pad Ethernet packets themselves (sometimes called "auto-padding") with random data obtained from a buffer.
The information contained in the buffer is used as padding in the Ethernet frame, and therefore is available to any
program that is monitoring network packets.

UnixWare closes this vulnerability by padding the Ethernet buffer with zeros at the DLPI level, before the driver (or
any other entity) has an opportunity to pad the buffer with non-zero data.

The system is updated with this enhancement by the nics package.
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Security: Updated zlib

The zlib data compression library package (/usr/lib/libz.so) has been updated to eliminate a security vulnerability
due to a buffer overflow condition in the gzprintf function. The zlib Manual from the zlib Home Page is available as
a manual page; enter man zlib or use the Man Pages button in DocView on http://hostname:8458.

Windows Interoperability: Samba 2.2.8a

Samba provides filesharing capabilities using native Microsoft SMB and CIFS protocols for interoperability with
Microsoft operating systems. Samba 2.2.8a is provided in two versions: a single-byte version for Western locales
(samba) and a multibyte version suitable for Asian locales (sambamb). The important difference between the two
versions is the sorting algorithm used for file ordering which determines whether the file sorting is compatible with
wide-character or ascii character code environments.

Note the following when installing Samba:

If you are upgrading from a previous release of Samba on UnixWare, save a copy of your existing
/usr/lib/samba/lib/smb.conf file before you begin installation, so you can restore any settings that might be
affected by the upgrade.

If Samba fails to start, make sure the directory /usr/lib/samba/private exists, that it has 755 permission, and
is owned by user root and group bin; then, start Samba, as shown:

# cd /usr/lib/samba
# mkdir private
# chgrp bin private
# chown root private
# /etc/init.d/samba start

By default, /tmp is automatically shared. This can be a security concern, since various system utilities keep
temporary data in /tmp. To remove the /tmp share, log into SWAT (see above) and select the Shares icon.
On the next screen, highlight the tmp share in the list box and select the Delete Share button.

Samba cannot run together with Advanced File and Print Sharing (AFPS; found on the Optional Services CD
#3), nor with the NetBIOS protocol running. If Samba will not start, do the following to determine if AFPS or
NetBIOS are running, and disable them if necessary:

1. Enter:

# cd /etc/rc2.d

2. Determine if either of the following files exist in this directory: 

S74netbios
S99ms_srv

If these one or both of these files exist, enter the appropriate command or commands shown below:

# mv S74netbios s74netbios
# mv S99ms_srv s99ms_srv

3. Reboot the system: 

# shutdown -i6 -g0 -y

4. Start Samba:

# /etc/init.d/samba start
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Samba is configured with the SWAT (Samba Web Administration Tool) utility using a web browser on
http://hostname:901; links to all the Samba documentation are provided from there. To start SWAT:

1. As root, enter:

# /usr/lib/samba/sbin/swat

2. Point a web browser at http://localhost:901.

3. Log in to SWAT as root.

4. The main SWAT screen provides links to all the Samba documentation. Select the Status icon to start
the Samba daemons.

To start, stop, and restart Samba from the command line, use the /etc/init.d/samba command, as in this
example:

# /etc/init.d/samba start

To enable Samba at system startup, enter the following:

# /etc/init.d/samba enable

Samba will now start up automatically whenever the system boots. The disable parameter returns Samba to
manual startup.

Localization settings in both the single-byte and multibyte versions are accessed from the SWAT Home Page
by clicking on the Globals tab, and then selecting Advanced View. Set appropriate values for your locale for
the client code page, the character encoding system, and the other options (each option has
context-sensitive help). Please refer to the documentation for smb.conf for futher details.

Note: the smbfs file system and associated commands (smbmnt, smbmount, smbumount) are not
supported on Release 7.1.3. Other client tools, such as smbspool, are supported.

More Samba documentation and other resources are provided on the Samba Home Page.

Update Pack 1 New Features

Update Pack 2 contains the following features that were delivered previously with Update Pack 1.

DocView Enhancements 
Emergency Recovery CD Support 
Emergency Recovery Master Boot Record Option 
Host Bus Adapter Drivers 
Network Card Drivers 
Networking: dlpid Performance Enhancements 
PPP Enhancements 
Printing PostScript Files on PCL Printers 
tcpdump Enhancements 
UNIX95 Conformance 

DocView Enhancements

The DocView documentation server displays the UnixWare documentation set on port 8458, and is enabled by
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default for network access. Point any browser on your network at http://hostname:8458, where hostname is the
network node name of the UnixWare system.

Two enhancements have been made to DocView:

Automatic Indexing 
A cron(1M) script has been added that generates the DocView index automatically when changes are made
to the installed documentation. The cron job runs every day at 0310 hours (3:10 AM local time), and is
installed by default. This process can take a significant amount of time depending on the amount of
documentation being indexed and available system resources. The cron job is enabled and disabled using
the following commands: 

# /usr/lib/docview/conf/set.rundig.cron --add
# /usr/lib/docview/conf/set.rundig.cron --remove

DocView Print Service 

A new printing interface has been added that allows you to pick a group of topics to be printed as a book.

Selecting the Print Book button at the top of the DocView screen opens a copy of the DocView Site Map,
from which you can select topics for printing by turning on the check boxes next to the listed topics. At the top
of the Print Service screen, select whether you want to generate a PostScript or PDF file. Specify a title for
the book, and the heading level to be used in the table of contents.

When you on the Submit button, the selected topics are collected, formatted for printing, and paginated. The
cover and custom table of contents are generated and added to the beginning of the document. 

When DocView is finished preparing the file, it displays a screen telling you the size of the file and the
number of pages in the document. Select the Proceed with download button to start downloading the file to
your browser (or save it to a file on your local system).

The resulting PDF file can be viewed with any PDF viewer (such as xpdf on UnixWare, or Acrobat on
Windows) or PDF-enabled browser. The PostScript file can be printed to a PostSript printer via lp, as in this
example:

$ lp -T PS -d printer file

Note that the assembled PDF or PostScript file is limited to about 1.5MB of HTML text, or about 600 pages. If
your selections exceed this limit, an error message is displayed. Select your browser's Back button to go
back to the Print Service screen and turn off some of your selections. 

Emergency Recovery CD Support

The emergency_disk(1M) command now supports creating an emergency recovery boot CD, as an alternative to
using boot floppies. In previous releases, a set of emergency recovery floppy disks was required to boot the
system. This meant that your system had to have a 3.5-inch floppy disk drive in order to be restored from
emergency recovery media. This is a problem for newer systems that do not support IDE floppy drives. Now,
emergency_disk can create a boot CD using CD-R or CD-RW media on an IDE, SCSI, or USB recordable CD
drive, so that boot floppies are no longer required. See the emergency_disk(1M) manual page for more
information.

Note that the cdrtools package (found on the UnixWare 7.1.3 Optional Services CD #3) is required to create an
emergency recovery boot CD, and that only CD-R, CD-RW, and DVD+RW drives that work with cdrtools are
supported for emergency recovery.

To test a particular drive to see if it will work with emergency_disk, enter the cdrecord commands shown below.
The first command returns the arguments you need in the second command. The second invocation of cdrecord
should return the string shown as part of its output:

# /bin/cdrecord -scanbus
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# /bin/cdrecord -inq dev=scsibus,target,lun
... 
Device seems to be: Generic mmc CD-RW.
...

The following CD drives are known to work with emergency recovery:

CenDyne/AOpen 48X12X50 USB 
HP DVD+RW 200i ATAPI 
LITE-ON LTR-52246S IDE 
Plextor CD-RW 16/10/40A ATAPI 
Plextor CD-RW 24/10/24U PX-W2410A USB 
Yamaha CD-RW CRW8824S SCSI 

Problems have been observed with the IOMEGA ZIPCD USB drive and the OPTORITE CD-RW CW4802 IDE drive.

To prevent a timeout problem when burning a CD using an IDE CD-RW drive, the following value in
/etc/conf/pack.d/ide/space.c is changed by the installation of the Update Pack from:

   int  atapi_timeout=10;

to:

   int  atapi_timeout=1000;

If you use cdrtools to burn CDs on an IDE hard drive but do not install the Update Pack, you can make the above
change manually, and then reboot to rebuild the kernel.

Emergency Recovery Master Boot Record Option

When restoring the system using emergency recovery boot media (CD or floppy), a new option to write the master
boot record (MBR) of the primary hard disk is displayed. This option writes the UnixWare MBR to the boot sector
of the primary hard disk. This option is useful if the disk is known to have a valid operating system (OS) on it, yet
the error No OS found, No operating system, or a similar message is displayed when you attempt to boot
from the disk. Writing the MBR may permit the disk to boot without further recovery. Note that any other OS boot
loader in the boot sector (such as grub, lilo, or System Commander) will be overwritten by this option. 

Host Bus Adapter Drivers

The following Host Bus Adapter (HBA) drivers are new or updated:

mpt
A new LSI Logic PCI to SCSI and Fibre Channel host adapter driver for LSI Logic Ultra320 and Fibre
Channel chipsets. For supported devices and other information, see mpt(7). 

qlc2200
Updated QLogic PCI FC host adapter driver to fix problems reported when removing disks from an IBM ESS
Storage Area Network (SAN) Cabinet. For supported devices and other information, see qlc2200(7). 

These drivers are not installed by the Upgrade Wizard (uli), unless (in the case of qlc2200), a previous version
exists on the system. To install them, use the pkgadd command. Follow Steps 1 and 2 of the Installation
Procedure, and then enter the following:

# pkgadd -d device package...

The device is cdrom1 if you followed Step 2a; or, /install if you followed Step 2b. Replace package with the
names of one or both of the drivers. This example installs the mpt driver from a mounted ISO image file:

# pkgadd -d /install mpt

See the Compatible Hardware Page for the latest supported HBAs and drivers.
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Network Card Drivers

The nd package on the Update Pack CD contains updated versions of the following network interface card (NIC)
drivers, which now support the indicated network cards:

eeE8

PRO/100+ Management Adapter (PILA8900)
PRO/100 Server (PILA8480)
Pro/100B T4 (PILA8475B)
PRO/100 S Server (PILA8474B)
PRO/100 S Server (PILA8474BUS)
PRO/100+ Dual Port Server Adapter (PILA8472)
PRO/100+ Server Adapter (PILA8470)
PRO/100+ Server Adapter (PILA8470B)
PRO/100+ Dual Port Server Adapter (61PMCA00)
PRO/100 (PILA8465)
PRO/100B Adapter (PILA8465B)
InBusiness 10/100 Adapter (SA101TX)
PRO/100 S Management (PILA8464B)
Pro/100+ Management Adapter (PILA8461)
Pro/100+ (PILA8460)
Pro/100+ Management Adapter (PILA8460B)
Pro/100+ (PILA8460BN)
PRO/100 S Management (PILA8460BUS)
Pro/10+ (PILA8500)
Pro/10+ (PILA8520)

e1008g

PRO/1000 Gigabit Server Adapter PWLA8490
PRO/1000 Gigabit Server Adapter PWLA8490G1
PRO/1000 F Server Adapter PWLA8490SX
PRO/1000 Gigabit Adapter PWLA8490SXG1P20
PRO/1000 T Server Adapter PWLA8490T
PRO/1000 T Server Adapter PWLA8490TG1P20
PRO/1000 XT Server Adapter PWLA8490XT
PRO/1000 XT Server Adapter PWLA8490XTL
PRO/1000 XT Lo Profile Server Adapter PWLA8490XTL
PRO/1000 XF Server Adapter PWLA8490XF
IBM Netfinity Gigabit Ethernet SX Adapter 09N3599
IBM Netfinity Gigabit Ethernet SX Adapter 30L7076
IBM Gigabit Ethernet SX Server Adapter 06P3718
IBM Gigabit Ethernet Server Adapter 22P4618
PRO/1000 MT Desktop Adapter PWLA8390MT
PRO/1000 MT Server Adapter PWLA8490MT
PRO/1000 MT Dual Port Server Adapter PWLA8492MT
PRO/1000 MF Server Adapter PWLA8490MF
PRO/1000 MF Dual Port Server Adapter PWLA8492MF

You can select the nd package when you use the Upgrade Wizard to install the Update Pack CD. To add the nd
package separately, see the instructions in the section Installing Additional Packages after the Update Pack 1 Set.

The UnixWare 7.1.3 nd package can also be installed on Release 7.1.2 (also known as OpenUNIX 8.0.0) or
Release 7.1.1 to update the network drivers or to take advantage of the enhanced tcpdump functionality (see
tcpdump Enhancements).

Please note the following when installing the Release 7.1.3 nd package on 7.1.1:
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You will also need to install ptf7689b ( view text file | download) on Release 7.1.1 before installing the
updated nd package; otherwise the latest tcpdump fails on Release 7.1.1 with the message dynamic
linker: tcpdump: binder error: symbol not found: strlcpy.

During installation on Release 7.1.1, the error UX:grep: ERROR: cannot open
/etc/inst/nd/mdi/shrkudi/Master: No such file or directory is displayed. This error
affects the UDI shrk driver only, which is not supported on Release 7.1.1. Use the MDI version of the shrk
driver instead.

Networking: dlpid Performance Enhancements

Poor system and network performance has been observed on some systems when one or more of the Network
Interface Cards (NICs) attached to the system is unplugged from the network. This was due to repeated failure
indications being sent to the dlpid(1M) daemon. 

In Release 7.1.3, a change was made to dplid to correct this problem. dlpid was changed to check the time
between successive hardware failure indications. If the time difference is less than 10 seconds, dlpid sleeps for a
10 second interval before trying the device again. 

dlpid has been further extended to sleep for a configurable duration between successive hardware failure
indications, to allow the NIC to reset and come out of the failure mode, in cases where the default 10-second wait
is not enough time for the NIC to reset. A new dlpid option, -r, is added to wait for the specified time. By default it
is set to 10 seconds. If the pre-7.1.3 behavior is required (i.e., no wait between successive hardware failure
indications), then dlpid can be started with the -r option set to 0. 

PPP Enhancements

Various enhancements were made to the pppd(1M) daemon to enhance the reliability and scalability of
Point-to-Point Protocol (PPP) connections. Most of these improvements were made to driver code, and so are not
visible at the user level. Some are listed in the section Problems Fixed.

Printing PostScript Files on PCL Printers

An lp(1) filter has been added to allow printing of PostScript files (such as those created by Netscape) to be
printed on PCL Printers (such as Hewlett-Packard). To enable this feature:

1. Install the latest ghostscript package from the Skunkware Web Site. 

2. Define a PCL printer using the scoadmin printer interface.

3. Enter a command like the following to print a PostScript file on the printer. 

lp -TPS -dpcl_printer file.ps

Where pcl_printer is the name of the printer and file.ps is the name of the PostScript file. This
command (without the file name) can be specified in your browser's preferences to print files automatically to
this printer.

tcpdump Enhancements

Version 3.7.1 of tcpdump(1M) is provided, along with its supporting library, libpcap(3) (version 0.7). The
tcpdump utility allows you to view and save TCP headers passing through a particular network interface. Boolean
expressions can be used to select only those headers that match the criteria given by the expression.

This version of tcpdump has many enhancements over the version (3.4a5) provided in UnixWare 7.1.3. Most
notably, the new version does not require a dedicated network card for tcpdump. Multiple instances of tcpdump
can be started to monitor the same card. See the tcpdump(1M) and pcap(3) manual pages. Also see the
tcpdump web site for libpcap tutorials, as well as tcpdump and libpcap source code.
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A number of changes to the MDI and DLPI interfaces were made to support the new version of tcpdump. 

Two new MDI ioctl commands are added for MDI2.2 drivers, to turn promiscuous mode on and off:
MACIOC_PROMISCON and MACIOC_PROMISCOFF. MACIOC_PROMISCON is compatible with
MACIOC_PROMISC in MDI2.1.

The following DLPI2.0 features are also implemented:

Allow sharing of SAPs by network interface cards. 
Support the DL_PROMISCON_REQ and DL_PROMISCOFF_REQ primitives. 

To support the above changes, updated header files dlpimod.h and mdi.h are provided in the nics package for
Update Pack 1, as well as the updated support for running tcpdump on a non-dedicated network card. tcpdump,
libpcap, and related header files are provided by the nd package. If the nd package is installed without the
updated nics package, the updated tcpdump, etc., are installed, but must be used with a dedicated network
controller as in previous releases.

The updated nd package can also be installed on Release 7.1.2 (Open UNIX 8.0.0) and on Release 7.1.1 if the
latest version of tcpdump is desired. The nics package is not supported and will not install on these earlier
releases, however, so tcpdump on Release 7.1.1 and 7.1.2 will continue to require a dedicated network card. 

UNIX95 Conformance

The following minor modifications have been made in order to maintain conformance to the UNIX 95 standard:

The dd command was modified to accept and ignore a double dash (--) as an end of options indicator. Note
that dd has no options that begin with a dash (-), so "--" can only appear as the leading argument and
consequently has no real purpose.

The sort command was modified to remove its previous (mistaken) UNIX 95 behavior. Previously, when
using sort -c with the POSIX2 environment variable set, sort only indicated whether the input was sorted
through its exit value. The sort command was changed for Release 7.1.3 to remove the dependency on the
POSIX2 environment variable, so that sort -c will always return a diagnostic if the input is out of order.

The two supported Korn shells (/bin/ksh and /u95/bin/sh) did not recognize an integer literal with a leading 0
as being octal, nor a leading 0x or 0X as hexadecimal in arithmetic constructs. This does not match the
intent of the POSIX.2 and OpenGroup shell specification. So, for example, the following output was seen in
previous versions of the Korn shell:

$ echo $((10+1))
11
$ echo $((010+1))
11
$ echo $((0x10+1))
/u95/bin/sh: 0x10+1: arithmetic syntax error

A change was made to work as intended when the POSIX2 environment variable is set:

$ export POSIX2=on
$ echo $((10+1))
11
$ echo $((010+1))
9
$ echo $((0x10+1))
17

Note that because integer constants like 010 have a silent change in behavior, this change requires POSIX2
to be set in the environment.

Minor namespace changes to the following header files:
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arpa/inet.h
netdb.h
netinet/in.h
netinet/in6_f.h
netinet/in_f.h
fmtmsg.h
grp.h
libgen.h
pwd.h
stdarg.h
strings.h
unistd.h
utmp.h
utmpx.h
wchar.h
sys/fcntl.h
sys/stat.h
sys/statvfs.h
sys/convsa.h
sys/stropts.h
sys/mman.h
sys/socket.h
sys/un.h
sys/regset.h
sys/siginfo.h
sys/ucontext.h
sys/fp.h

Problems Fixed

Update Pack 2 (uw713up2) contains all the fixes from Maintenance Pack 1 (uw713mp1), Maintenance Pack 2
(uw713mp2), and Update Pack 1 (uw713up1), plus additional fixes. See the lists below. The identifiers at the end
of each description are SCO escalation and problem report numbers.

Problems fixed in Maintenance Pack 1 
Problems fixed in Update Pack 1 
Problems fixed in Maintenance Pack 2 
Problems fixed in Update Pack 2 

Problems fixed in Maintenance Pack 1

uw713mp1 contained the following fixes:

1. Prevents system panics previously caused when fusers examines an exiting process. 
fz526462 

2. Prevents hangs seen on Compaq ML350 and ML370 Systems when hyperthreading (Jackson Technology) is
enabled, i.e., when the boot parameter ENABLE_JT is set to YES. 
fz526444 

3. Fixed problems with the CDE desktop help viewer. 
fz526501 

4. Provides missing scoadmin filesystem files that were not installed when upgrading from UnixWare 7.1.1 or
Open UNIX 8.0.0. 
fz526550 
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5. Provides updated /usr/include files that were not installed when upgrading from UnixWare 7.1.1 or Open
UNIX 8.0.0. 
fz526552 

6. Provides a new makewhatis(1M) command that was not installed when upgrading from UnixWare 7.1.1 or
Open UNIX 8.0.0. 
fz526526 

7. Fixed crash(1M) to recognize changes to the callout structure. 
fz518517 

8. Fixes issues target disk driver error recovery. 
fz520729 

Problems fixed in Update Pack 1

uw713up1 contains all the fixes listed above for uw713mp1, plus the following additional fixes. Fixes listed with
(MP2) at the beginning of the description are also included in Maintgenance Pack 2 (MP2); see Problems fixed in
Maintenance Pack 2.

Security Fixes

9. (MP2) Closing file descriptors 0, 1 and/or 2 before exec'ing a setuid program can make this program open
files under these file descriptors, which have special meanings for libc (stdin/stdout/stderr). Reading
or writing to root-owned files can be made possible, since stdin/stdout/stderr==opened_file. 
erg712059/fz526562/CSSA-2002-SCO.43

10. (MP2) A rogue talk client is able to cause the talk demon to overrun a buffer, and could be able to
compromise a machine running talkd. 
erg712055/fz521053/CSSA-2002-SCO.42

11. (MP2) Buffer overflow in XPR portion of libnsl library. 
erg712182/fz526861/CSSA-2003-SCO.7 

12. (MP2) A command line buffer overflow in ps command can be exploited. 
erg712109/fz525292/CSSA-2003-SCO.1 

13. (MP2) The implementation of xdr_array can be tricked into writing beyond the buffers it allocated when
deserializing the XDR stream. 
erg501642/fz525725/CSSA-2003-SCO.7 

14. (MP2) Fixed a security vulnerability in the sendmail binary that can be exploited by remote users to gain root
access. 
fz527484/erg712247/CSSA-2003-SCO.5 

15. (MP2) When using ftp to transfer a file with a pipe as the first character in its name (for example, |xyz), ftp
executes the file on client machine. 
erg712227/fz527425/CSSA-2003-SCO.3 

Networking Fixes

16. (MP2) Panic in PPP driver - pppwsrv() - due to a race condition. 
erg501673/fz526330 

17. (MP2) Panic in PPP's pcid driver. 
erg501650/fz525867 

18. (MP2) Communication problem between pcid and ppp driver. 
erg501678/fz526352 

19. (MP2) The ttymon process sometimes stops listening to a port after PPP disconnect. 
erg501634/fz525626 

20. (MP2) When receiving data from a TCP socket it may lock up indefinitely with data buffered up in the kernel
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but never returned to the process. 
erg501604/fz520887 

21. (MP2) Connection server fails with the following error:

10/24/02 17:14:51; 27209; cs: ioctl() set signal error; errno=22

erg712153/fz526540 

22. (MP2) Improved network printing performance. 
erg712041/fz520932 

23. (MP2) If an ftp client host was reset (as in cycling the power) during the data transmission to the server, the
ftp-data connection never times out on the server. If the client tries to use again the same port after reboot
for an ftp transmission, the server responds with EADDRINUSE. 
erg501703/fz526973 

24. (MP2) After removing a network interface, pkgchk nics complains about missing files. 
erg712152/fz526505 

25. (MP2) Repeated logins on virtual terminals (/dev/vt02 ... /dev/vt08) result in file descriptor leakage in ttymon.

erg501636/fz525650 

26. (MP2) When excessive short-lived rlogin sessions are being created, /var/adm/wtmp and /var/adm/wtmpx
get out of sync and must be rewritten. While these files are being rewritten, no one can rlogin to the system.
If these files grow quite large, this can take up to 20-30 minutes. Also under heavy load the short-lived rlogin
sessions may leave in utmp the entries from sessions that have actually completed. 
fz526496/erg712151 

27. (MP2) Can't write to /dev/_tcp/num tty device (rlogin connection). 
erg712250/fz526110 

28. (MP2) Occasionally bind() returns EADDRINUSE for no apparent reason. 
erg712209/fz527217 

29. (MP2) Fixed tape driver bug relating to SAN attached tape drives. 
erg712195/fz526396 

30. (MP2) Fixed an NFS panic which can occur following certain types of transmission errors. 
fz526648 

31. (MP2) Cleaned up code which handles dispatching of tcp timers. 
fz526796 

32. (MP2) Panic in tcp_close. 
fz527439/erg712230 

33. The function write(2) erroneously returns EISCONN on a raw socket. 
erg501681 fz526404 

34. Fixed an NFS hang which can occur when mounting an NFS file system. 
fz526665 

35. Unplugged network cable causes terrible interactive console performance. 
fz520663 

36. System panic while running LSV inet stress tests (GetService). 
fz526345 

37. The utility cs(1Mbnu) fails to include the phone number. 
erg501670, fz526315 

38. PPP stability and scalability improvements. 
fz527328 

Miscellaneous Fixes
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39. (MP2) Multi-threaded application may hang in an unkillable sleep, during exec. 
erg712172 fz526750 

40. (MP2) Fix for sdiadd -n panic on systems with a pre-DDI8 Host Bus Adapter (HBA). The problem was that
sdi_hot_add() was not converting the older style SCSI address into the newer extended SCSI addressing
scheme properly. The original fix set the address to -1's instead of 0's for the wildcard case. pdi_hot will set
the SCSI address to all -1's to tell SDI that we want to scan the entire SCSI bus starting from absolute
address 0/0/0/0 (controller/bus/target/lun). 
erg712223 fz527360 

41. (MP2) Added minor command modifications required by The Open Group for UNIX95 certification. For
details, see UNIX95 Conformance. 
fz526395/fz526629/fz527377 

42. (MP2) The emergency_disk(1M) boot media hangs on system with more than 4 GB RAM. 
fz527578 

43. (MP2) Added undocumented option noquota to the vxfs mount command to fix the problem where the
output of mount -p when used in /etc/vfstab, is rejected by mount with the message:

UX:vxfs mount: ERROR: illegal -o suboption -- noquota

erg712190 fz526894 
44. (MP2) The kernel can panic in mod_dev_load if a DDI8 driver does not get configured properly. 

fz526791 

45. (MP2) Repeated logins on virtual terminals (/dev/vt02 ... /dev/vt08) result in file descriptor leakage in ttymon.

erg501636 fz525650 

46. System hangs due to multiple, racing calls to stropen. 
erg501706 fz527158 

47. lint(1) previously warned about _nanf() and nanf() in math.h. Adding a /*LINTED*/ line in front of each
suppresses this noise. 
fz527588 

48. The utility cs(1Mbnu) exits unexpectedly due to fork(2) failure. 
erg501710 fz527253 

49. The emergency_rec(1M) command doesn't ignore commented entries in /usr/lib/drf/tapeconfig. 
fz527399 

50. The command pwck(1M) should print the line being processed, when errors are encountered. 
erg712157 fz518020 

51. Fix locking of CD-ROM tray. 
fz527497 

52. The command sar -d returns busy values > 100% 
fz521100 erg501658 

53. Fixed bugs which caused the licensing daemons (ifor_pmd, ifor_sld, and sco_cpd) and the idmknodd
daemon to be killed on transitions to init state 1 and never restarted. 
fz526649, fz526656 

54. The mousemgr process could not be run in init state 1. 
fz527032 

55. Updated /sbin/usb to only run when usbd is configured. 
fz527495 

56. Fixed potential problem evaluating constant expressions in full_optimization asm(1) functions. 
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fz527501 

57. Panic in the routine v86bios0(). 
fz526652 

58. Include support tool sysinfo(1M) in shipping product. 
fz519999 

59. Intel's fix for p6update panics on prototype Pentium 4 Xeon system. 
fz521607 

60. Kernel panic in kmem_alloc, from tcpopen. 
fz521356 

61. New tunable COREFILE_SECURE. Privileged, setuid or setgid processes are prohibited from dumping core.
A new tunable COREFILE_SECURE, if tuned to 0, will allow such processes to core dump. 
fz526524/erg712163 

62. System hangs sporadically after calling execv directly after fork1 in multithreaded applications. 
fz526597 

63. Netscape postscript printing in kole (Korean) environment is broken. 
fz520071 

64. If the Skunkware ghostscript package is installed, the PostScript files (such as those printed by Netscape)
can be automatically converted for printing on the PCL printers (such as HP LaserJet). An example of
command to enter in the Netscape print dialog:

         lp -T PS 

65. Correctly display version of dump command with -V option. 
fz518607 

66. Fix for missing charset attribute for Japanese documentation in DocView. 
fz526356 

Development Fixes

67. Assembly peep-hole optimizer (optim) fix for three operand integer multiplication by one which was not
caught by the global optimizer on C++ code. 
fz526555 

68. C++ compiler fix: Unless in strict ANSI mode, allow an undefined inline function to be referenced if the point
of reference is never used. 
fz526499 fz526480 

69. Debugging information for a "long long" local variable assigned to register pair %ebx/%esi was incorrectly
stated as %ebx/%esp. C and C++ compilers fixed. 

Compatibility Fixes

70. (MP2) Fix for panic on certain OpenServer binaries. 
erg550013/fz514721 

71. (MP2) chown() arguments of -1 do not work for OpenServer binaries 
fz526683 

Problems fixed in Maintenance Pack 2

uw713mp2 contains all the fixes listed above for Maintenance Pack 1, the fixes marked (MP2) delivered with
Update Pack 1, plus the following fixes:

Security Fixes:
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72. uudecode does not validate the filename; it should not write to pipes or symbolic links. 
CSSA-2002-SCO.44 

Networking Fixes:

73. KMA corruption in tcp. 
fz521356/erg712086 

74. Status requests are not being automatically generated for a network printer if it is very busy resulting in job
ids not being freed. 
erg501666/fz526164 

75. Hangs and delays in streams caused by streams routines unnecessarily allocating large physically
contiguous buffers. 
fz527550/erg712266 

Compatibility Fixes:

76. Fixed system call restart code for OpenServer applications. Also modified code for the connect system call
so that connect is properly restartable for OpenServer applications. 
fz527264 

77. System hangs during boot up on older (Pentium III and earlier) IBM hardware. 
fz527522 

78. Allow use of an ELF interpreter which contains a PT_NOTES section, as some older OpenServer libraries do. 
fz527571 

79. Enable 16-bit IPC IDs for OpenServer and Xenix compatibility. 
fz527373 

80. Implement support of MAP_NOEOF mmap flag for OpenServer applications running on UnixWare. 
fz527536 

Miscellaneous Fixes:

81. Fixed an unrecoverable "internal error" experienced by the debug command when reading some core files
from threaded applications. Fixed the recently added -m command line option to specify an alternate runtime
library path when analyzing core files from other systems. 
erg501675/fz526224/fz526635/fz526681 

82. The vtoc driver has been fixed to support disks whose physical sector size is an integral multiple of 512. 
erg501717/fz527726 

83. System may refuse to take console input after 248 days, thereby appearing to hang, due to invalid time
stamps in the cmux driver. 
fz527517/erg501720 

84. The command useradd(1M) allows $ in usernames (SAMBA requirement) 
fz526483 

85. The ksh95 built in pwd command can output pathnames starting with //. 
fz199364 

86. PSE memory remains unavailable after dynamically adding memory. 
erg712235/fz527455 

87. System hangs in vxfs filesystem. Processes blocked waiting on a call to vx_iget. 
erg712184/fz526355 

88. Restore the pre-7.1.3 lookuppn syntax so that third-party provided filesystems continue to work. The extra
root vnode argument has been removed from lookuppn. A new lookuppnx function has been created with
this extra argument. 
fz527503 

Problems fixed in Update Pack 2

uw713up2 contains all the fixes listed above for Maintenance Pack 1, Update Pack 1, and Maintenance Pack 2,
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plus the following additional fixes.

Networking Fixes:

89. Hangs and delays in streams caused by streams routines unnecessarily allocating large physically
contiguous buffers. 
fz527550 erg712266 

90. If two arp -d's are called in quick succession, one of the entries may not be deleted. 
erg711628/fz516107 

91. When DNS is not configured, mailadmin (scoadmin mail) will not allow you to change any settings. 
erg712296/fz527783 

92. System panic due to a race condition in tcp timers code. 
erg501722/fz527554 

93. Fixed scoadmin DNS Manager' abnormal terminations; fixed corruption of DNS/BIND's configuration and
zone data files caused by scoadmin DNS Manager; fixed ndc/rndc utility and interactions with DNS/BIND. 
fz518460 fz518604 fz521436 

Compatibility Fixes:

94. If the name of remote system for a remote printer is not found in /etc/lp/Systems, lpsched does not complain
at startup and later on coredumps when a status or cancel request is sent to that printer. 
fz527931 

95. Remote print requests remain indefinitely in queue if remote system is down. They do not timeout even if
timeout parameter is specified in /etc/lp/Systems for the corresponding remote system. 
fz527934

WARNING: Since by default the timeout is set to 10 minutes, print setups with large network delays may
suddenly experience timed-out jobs. For such systems, system administrators should either increase the
timeout value or set timeout to "never" to restore old behavior.

Miscellaneous Fixes:

96. System can refuse to take console input after 248 days, thereby appearing to hang, due to invalid time
stamps in the cmux driver. 
fz527517 erg501720 

97. Short-lived floating point temp value may be left on the floating point stack when used within the second or
third operand of a conditional operator. This may result in a floating point stack overflow. 
fz527712 

98. Potential floating point stack overflow detected in /usr/sbin/vxassist. 
fz527712 

99. Shell metacharacters that are part of the options to the C++ compiler are properly preserved (escaped) for
reuse during recompilation done as part of C++ auto template instantiation. 
fz527527 

100. Fixed an unrecoverable "internal error" experienced by the debug command when reading some core files
from threaded applications. Fixed the recently added '-m' command line option to specify an alternate
runtime library path when analyzing core files from other systems. 
erg501675 fz526224 fz526635 fz526681 

101. The vtoc driver has been fixed to support disks whose physical sector size is an integral multiple of 512. 
erg501717 fz527726 

102. Fixed division by zero error in /usr/ccs/lib/optim encountered in calculating potential benefits of locals in a
register for what appears to be a series of heavily nested loops. 
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103. Fix to ps -o time so that when the accumulated CPU time exceeds 24 hours, the number of days is no longer
off by one. 
fz527776/erg712295 

104. Change the "enum boolean" tag in /usr/include/sys/types.h to "enum __boolean", removing the type/tag
"boolean" from the user name space. 
fz527818 

105. Add support for Digi ClassicBoard/PCI and Connect Blue Heat serial cards. 
fz527694 

106. System hangs in vxfs filesystem. Processes blocked waiting on a call to vx_iget. 
erg712184 fz526355 

107. Restore the pre UnixWare 7.1.3 lookuppn syntax so that third-party provided filesystems continue to work.
The extra "root vnode" argument has been removed from lookuppn. A new lookuppnx function has been
created with this extra argument. 
fz527503 

108. Status requests are not being automatically generated for a network printer if is very busy resulting in job ids
not being freed. 
erg501666 fz526164 

109. Display per-processor callouts as well as global callouts from the callout command. 
fz527802 

110. Enhanced the Printing subsytem to have a maximum of 999 printjobs per printer or class of printers rather
999 printjobs for the whole system. 
erg501712/fz526370 

111. Lpsched performs poorly when a large number of jobs (200+) are submitted at once. 
erg501718/fz527462 

112. The sdipath -o repair command can hang when run against active paths. 
erg712254/fz527498 

113. PSE memory remains unavailable after dynamically adding memory. 
erg712235 fz527455 

114. Periodic Local timeouts can migrate to global callout lists. If a driver uses a dtimeout interface to schedule a
periodic callout on a particular cpu, the callout migrates to the global list after the first firing. This then allows
allows callout to be scheduled on any cpu. 
fz527675 

115. scoadmin now includes a graphical disk manager 
fz527823 

116. xAPIC support for IBM xSeries x440 servers - allows multiple CECs to be used and more than 8 logical
CPUs 
fz526749 fz527522 

117. Fix the ksh problem where an empty assignment (for example, ksh -c 'x=; echo ${x/y/z}') would cause a
memory fault. 
fz527943 

118. Change umask to 022 so that /etc/ssh.pid is not world writable. 
fz526605 

119. Correct /usr/sbin/sshd binary to use /usr/X/bin/xauth instead of /usr/X11R6/bin/xauth. 
fz526871 
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120. Added STO_386_COPY support to RTLD and the linker to aid in the evolution of the IA32 psABI. 
fz527833 

121. Add support for the BSD and Linux asprintf() and vasprintf() routines. These two routines are additional
*sprintf() variations. Here, you pass the address of a "char *" into which is placed a malloc()d buffer of
sufficient length to hold the entire sprintf() result. The caller is responsible for free()ing the buffer when done. 
fz527834 

122. Correct /usr/include/sys/nattr.h definition of NATTR_CSUM_MASK. 
fz527534 

Fixes Included in Additional Packages in Update Pack 2:

The following fixes are not included in the uw713up2 set; they are installed with the indicated package provided
on the Update Pack 2 CD and on the download site. See Update Pack 2 CD Contents.

1. adst70 - Provide updated adst70 HBA driver to prevent a panic going into init 1. 
fz527526 

2. basex - Avoid potential duplicate data being flushed from buffers when the child process, used for initial
house keeping, in the pseudo tty client open transport function exits. 
fz527709 

3. nd - Updated Intel PRO/100 driver (eeE8) to version 2.5.4. Bug fixes and new card support. 
fz527508 fz527922 

4. nd - Updated Intel PRO/1000 driver (e1008g) to version 7.0.11. Bug fixes and new card support. 
fz527502 fz527911 

5. nd - Correct typos in Intel PRO/1000 (e1008g) Drvmap file affecting hotplug support for certain NICS. 
fz527792 

6. nics - Short Ethernet frames are now padded with octets of zero to prevent information leakage. 
erg712090 fz521367 

7. openssh - SECURITY Provide rlogin/telnet login replacements to correct flawed kill routine. 
fz526587 

8. openssl - SECURITY Upgraded OpenSSL version to fix timing attack vulnerability. 
fz527507 

9. samba and sambamb - SECURITY Upgraded Samba version to fix security wholes where anonymous or
remote users could gain root access. 
fz527530 fz527681 

10. xdrivers - Matrox G100/G200/G400 Series Graphics driver (mtx) doesn't close pcix driver causing xserver
package to hang during installation. 
fz527729 

11. xdrivers - Provide support for Nvidia TNT2, GeForce2 and Quadro2 Graphics adapters. 
fz527795 

12. zlib - SECURITY Fix a zlib (gzprintf) format string overflow vulnerability by rebuilding the zlib library to use
snprintf(). 
fz527490 

Known Problems and Workarounds
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DocView: "Print Book" Problems 
Installation: xAPIC Support 
Installation: OpenSSH requires OpenSSL 
Installation: Timezone and Locale Clashes Display Warnings 
Installation: Upgrade Wizard Exits if Space Pressed Repeatedly 
Installation: Warnings About Changed Files 
Mozilla: Japanese characters are not echoed as they are typed 

DocView "Print Book" Problems with non-English Text

Problems have been observed with the DocView (http://hostname:8458) PRINT BOOK facility:

1. Some files do not print when selected from the PRINT BOOK list, or the incorrect content is printed instead.
This occurs in C and non-C locales.

2. Multibyte files cannot be printed (this includes, for example, Japanese-language documentation from the
jabasedoc package on the Localized Documentation CD in the UnixWare Media Kit) from the PRINT BOOK
list. This is because the underlying engine in DocView for printing HTML (HTMLDOC) does not support
multibyte files.

3. Some documents are not being printed in foreign languages when locale is properly selected and the
foreign-language documentation is installed.

The workaround in all these cases is to display the files individually from the DocView SITE MAP interface (which
is identical to the PRINT BOOK list), and use your browser's Print command to print the files.

For example, if you use the PRINT BOOK interface to print a New Features file and it does not work, click on the
SITE MAP button on the DocView menu (http://hostname:8458) and select the name of the link that you wanted
to print (the SITE MAP and PRINT BOOK lists are identical). Once the document is loaded into the browser, print
it using your browser's Print command (File > Print in Netscape) to print to a local printer or to a file. The formats
available depend on your local browser's setup. 
527817

Installation: xAPIC Support 

Update Pack 2 includes xAPIC support for IBM x440 systems. On some platforms, such as the IBM xSeries 360
(x360), the OS detects it should use xAPIC but the platform does not properly support it. If this happens, the
symptoms are device timeouts (either a disk driver or HBA) very early during the boot process. The system will
display a message stating that an HBA or disk command has timed out, and the system will become unresponsive
(hang). If you are using a Multi-Processing (MP) system with Pentium 4 (Xeon) processors and this occurs do the
following:

1. Reset the system.

2. When the system displays the UnixWare logo during the boot sequence, interrupt the boot by pressing any
key.

3. At the boot prompt enter:

USE_XAPIC=N
boot

The system should now boot normally.

4. Once the system is running, edit /stand/boot and add the following entry to the file:

USE_XAPIC=N

This will ensure that you do not need to interrupt the boot process again.
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Installation: OpenSSH requires OpenSSL

You may see the following error during installation of the OpenSSH (openssh) package:

##Executing postinstall script.
dynamic linker:  /usr/sbin/sshd: could not open libcrypto.so.0.9.7
Killed
/etc/init.d/opensshd: Error 137 starting /usr/sbin/sshd....Bailing.

This indicates that the OpenSSL (openssl) package is not installed; the installation of openssh, however, will still
report success. To fix this, install the openssl package from the Update Pack 2 media and then re-install
openssh. 
527982

Installation: Timezone and Locale Clashes Display Warnings 

If you install Update Pack 1 on a freshly installed UnixWare 7.1.3 system, you may see Warning messages during
installation of the packages on the Update Pack 1 CD image. This happens most commonly when you specify the
correct local time when installing UnixWare 7.1.3, but select a locale whose timezone differs from the local
timezone. As a result, there can be a mismatch between the current system time and the time stamp on the files
installed from Update Pack 1, which causes the following warning to be displayed: 

WARNING: Reapply uw713u1 package.  Failure to do so may leave your
         system in an inconsistent state.

If this occurs, execute the following command:

pkginfo -l | grep INSTDATE | sort -u | more

Wait until the latest time returned by the above command has passed, and then reinstall the the uw713u1
package:

pkgadd -d device uw713u1

Where device is the location of the mounted Update Pack 1 CD or CD image, or the location of the Update Pack
image. 
527540

Installation: Upgrade Wizard Exits if Space Pressed Repeatedly

When launching the Upgrde Wizard using the uli command from a desktop window, the Upgrade Wizard may exit
unexpectedly if you press the space bar a few times while it is loading. To work around this, re-run the Upgrade
Wizard. 
527905

Installation: Warnings About Changed Files

During installation of Update Pack 1 on a system that was upgraded from a release prior to Release 7.1.3,
warnings such as the following may be displayed:

UX:pkginstall: WARNING: /etc/conf/pack.d/msr/Driver.o <shared file is volatile>
UX:pkginstall: WARNING: /etc/conf/pack.d/pcid/Driver.o <shared file is volatile>
UX:pkginstall: WARNING: /etc/conf/pack.d/ppp/Driver.o <shared file is volatile>
UX:pkginstall: WARNING: /etc/conf/pack.d/pppml/Driver.o <shared file is volatile>
...

The Warnings displayed on your system will depend on the originally installed release. These Warnings are
expected and can be safely ignored. 
527406

Mozilla: Japanese characters are not echoed as they are typed
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Japanese characters are not displayed as they are typed (using the X input method, invoked by typing a
"shift-space") when filling a text or dialog box. The Japanese characters are instead displayed when "Enter" is
pressed. This behavior is the default setting of the xim.input_style attribute in the Mozilla browser. 

If users desire to have characters displayed as they are typed, they need to add the following line:

user_pref("xim.input_style", "over-the-spot");

to their preferences java script file, typically $HOME/.mozilla/default/*/prefs.js.
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